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CE-SDS Protein Analysis 试剂盒 1
CE-SDS Protein Analysis 试剂盒提供了用于按大小分辨还原和非还原蛋白质以及对蛋白质分
离中可能存在的异质性和杂质进行量化的试剂和耗材。

本文档提供了使用 CE-SDS Protein Analysis 试剂盒进行样本制备的说明。它还提供了使用
BioPhase 软件和 Waters Empower™ 软件结合 BioPhase 8800 driver for Empower™ 采集数据
的说明。本文档还提供了对使用 BioPhase 软件采集的数据进行分析的说明。对使用 Waters
Empower™ 软件采集的数据进行的分析必须使用 Waters Empower™ 软件完成。

使用此应用程序指南中的信息作为起点。根据需要，更改进样时间、电压、进样类型或其他参
数，以寻找适合您需要的最佳条件。

注释: 有关系统安全使用的说明，请参阅文档：《操作员指南》。

安全性
关于妥善处理材料和试剂的信息，请参阅可从 sciex.com/tech-regulatory 获得的安全数据表
(SDS)。始终遵循标准实验室安全规范。关于有害物质信息，请参阅以下章节：有害物质信
息。

预期用途
CE-SDS Protein Analysis 仅供实验室使用。

简介
CE-SDS Protein Analysis 试剂盒包括用于按大小分辨还原和非还原蛋白的试剂，以及对蛋白
质中可能存在的异质性和杂质进行量化的试剂。该方法涉及在有十二烷基硫酸钠 (SDS) 存在
的情况下对指定浓度的蛋白质进行热变性。变性之后，样本在含有可替换 SDS 聚合物基质
（可提供分离所需的筛分选择性）的毛细管中按大小分离。

工作流程

工作流程包括下列步骤：

1. 确定要分析的样本数量和重复次数。

2. 对于 BioPhase 软件用户：

a. 创建或修改方法。请参阅以下章节：方法。

b. 创建序列以及样本和试剂孔板布局。请参阅以下章节：创建序列。

3. 对于 Waters Empower™ 软件用户：

a. 导入 BioPhase 软件方法。请参阅以下章节：导入 BioPhase 软件方法以创建仪器方
法。

CE-SDS Protein Analysis 试剂盒
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b. 创建样本组方法以及样本和试剂孔板布局。请参阅以下章节：创建样本组方法。

4. 制备样本。请参阅以下章节：制备样本。

有两个独立的工作流程：还原和非还原。

5. 使用样本和试剂孔板布局准备孔板。

6. 将孔板放进 BioPhase 8800 系统。请参阅以下章节：加载样本入口和出口孔板和加载试
剂入口和出口孔板。

7. 开始数据采集。

• （BioPhase 软件）从前面板启动序列。请参阅以下章节：运行样本。

• （Waters Empower™ 软件）从带有 BioPhase 8800 driver for Empower™ 的 Waters
Empower™ 软件启动样本组方法。请参阅以下章节：启动样本组方法。

8. 分析数据。

• （BioPhase 软件）当序列完成后，使用 BioPhase Analysis 软件分析数据。请参阅以
下章节：分析数据。

• （Waters Empower™ 软件）当样本组方法完成后，使用 Waters Empower™ 软件分析
数据。如需数据分析说明，请参阅 Waters Empower™ 软件指南和帮助文件。

CE-SDS Protein Analysis 试剂盒
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所需设备和材料 2
注释: 对于具有重新订购产品号的组分，有时重新订购数量与试剂盒中的数量不同。

表 2-1 CE-SDS Protein Analysis 试剂盒 (PN C30085)

组分 数量 重新订购产品号

10 kDa Internal Standard 2 A26487

Acid Wash/Regenerating Solution (100 mL) 1 不适用

Capillary Regenerator Solution A Basic Wash (100 mL) 1 不适用

CE Grade Water (140 mL) 3 C48034

CE-SDS Gel Buffer (140 mL) 2 A30341

Low pH SDS Sample Buffer (55 mL) 1 C44807

SDS-MW Sample Buffer 1 不适用

表 2-2 来自 SCIEX 的其他用品

组分 数量 产品号

（可选）Low pH Phosphate SDS Sample Buffer（40
mM 磷酸盐，pH 6.5，1% SDS）(140 mL)

1 C57805

毛细管卡盒冷冻剂 (450 mL) 1 359976

IgG Control Standard (1 mg/mL) (1 mL) 3 391734

MW Size Standard（大小梯度包含 10 kDa、20 kDa、35
kDa、50 kDa、100 kDa、150 kDa 和 225 kDa 蛋白质）
(100 µL)

3 A22196

BioPhase 8800 无涂层熔融石英毛细管卡盒（50 µm 内径
× 30 cm 毛细管）

1 5080121

BioPhase 8800 出口孔板 20 5080315

BioPhase 8800 试剂孔板 20 5080314

BioPhase 8800 样本孔板 20 5080313

BioPhase 8800 启动剂孔板包（4 个样本孔板，4 个试剂
孔板，8 个出口孔板）

1 5080311

所需设备和材料

CE-SDS Protein Analysis 试剂盒 适用于 BioPhase
8800 系统
8/77

应用指南
RUO-IDV-05-8662-ZH-D



表 2-3 其他必需试剂或用品

描述 供应商 产品号

（可选）Amicon Ultra-4 离心过滤装置，含 Ultracel-10 滤
膜

MilliporeSigma UFC801024

（可选）MicroCon-10 kDa 离心过滤装置，含 Ultracel-10
滤膜

MilliporeSigma MRCPRT010

（可选）MicroCon-30 kDa 离心过滤装置，含 Ultracel-30
滤膜

MilliporeSigma MRCF0R030

2-巯基乙醇 MilliporeSigma M7154

碘乙酰胺 MilliporeSigma I-1149

X-Pierce 膜 USA Scientific 2997-0100

储存条件

注释: 关于已制备试剂的储存条件，请参阅制备说明。

• 收到后，将 10 kDa Internal Standard 储存在 2 °C 至 8 °C 条件下。

• 试剂盒中的其他物品可储存在室温条件下。

客户提供的设备和用品
• 无粉手套，推荐氯丁橡胶或丁腈手套

• 护目镜

• 实验服

• 合适的离心机

• 微型离心机或同等产品，以及微量离心管

• 漩涡混合器

• 移液器和适当的吸头

在准备试剂孔板时，建议使用连续移液器或同等产品。

• 封口膜

• 离心机，配有吊桶式转头以容纳孔板

• 37 °C 至 100 °C 温度的水浴或加热器

• 分析天平

• 刮板

所需设备和材料
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所需检测器
需要配有 220 nm 滤光片的 UV 检测器。

所需卡盒

小心: 潜在的错误结果。如果卡盒与 CE-SDS Protein Analysis 试剂盒一起使用，则不要将同
一卡盒用于其他用途。如果同一卡盒中包含不同的缓冲剂和样本类型，则可能会发生样本残
留、非特异性结合和分离不佳等问题。

需要装有 50 µm 内径 × 30 cm 毛细管的 BioPhase 8800 BFS 毛细管卡盒。

请参阅表格：表 2-2。

所需设备和材料
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方法和序列 3
对于使用 BioPhase 软件的系统

注释: 如果已验证的方法和序列未包含在软件中，则可从 SCIEX 网站下载它们。请参阅以下章
节：下载和配置必需文件（BioPhase 软件）。这些方法也可通过 BioPhase 软件手动创建。
请参阅以下章节：方法。

需要下列方法和序列。

• CE-SDS 调节：调节毛细管。

• 分离方法：

• 还原 CE-SDS 分离：用于还原样本。

• 非还原 CE-SDS 分离：用于非还原样本。

• 低 pH 样本缓冲剂分离：用于使用低 pH 样本缓冲剂制备的样本。

• CE-SDS 关闭：在序列结束时清洁毛细管，冲洗毛细管以便储存，然后关闭灯。

• 序列模板：

• 还原 CE-SDS 分离：用于还原样本。

• 非还原 CE-SDS 分离：用于非还原样本。

• 低 pH 样本缓冲剂分离：用于使用低 pH 样本缓冲剂制备的样本。

对于使用 Waters Empower™ 软件的系统

通过导入 BioPhase 软件方法创建必需的仪器方法。

注释: 如果方法未包含在软件中，则可从 SCIEX 网站下载它们。请参阅以下章节：下载和配置
必需文件（Waters Empower™ 软件）。这些方法也可通过 Method Editors for BioPhase
System 软件手动创建。请参阅以下章节：方法。

创建序列

注释: 如果要使用 Waters Empower™ 软件采集数据，则此程序不适用。请参阅以下章节：创
建样本组方法。

注释: 本程序假定您熟悉 BioPhase 软件。如需详细说明，请参阅文档：《软件帮助系统》。

此程序提供了使用 BioPhase 软件中随附的模板创建序列的说明。该模板的第一列中可设置八
个样本，并使用软件随附的经过验证的方法。

创建序列时也可以不使用模板。在大多数情况下，序列应从调节方法开始，然后是分离方法，
并以关闭方法结束。关闭方法应指定为错误恢复方法。请参阅文档：《软件帮助系统》。

方法和序列
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注释: 如果序列包含重复样本，则确保重复样本位于样本孔板的同一行中，以减少任何毛细管
间差异。

1. 在 BioPhase 软件的主页上，单击 Sequence Editor。

2. 单击 Open Sequence。
Open a Sequence 对话框随即打开。

3. 搜索并选择合适的序列：

a. （可选）为每个搜索键入 Start Date 和 End Date，或者单击日历图标，选择日期，
然后单击 Search。
可用的项目文件夹显示在 Folder Name 窗格中。

b. 单击 CE-SDS Project 项目文件夹。
项目中的可用序列显示在右侧的表格中。

c. 在该表中，选择合适的序列模板，然后单击 Open。

• 对于还原样本，单击 CE-SDS 测试序列。

• 对于非还原样本，单击 非还原 CE-SDS 序列。

• 对于使用低 pH 样本缓冲剂制备的样本，单击 低 pH 样本缓冲剂 CE-SDS 序列。

Open a Sequence 对话框关闭，然后 Sequence Summary 选项卡打开。

4. 在 Sequence Summary 窗格上方，单击 Edit。
Sample Plate Setup 选项卡打开。

5. 如有必要，执行任何下述操作：

• 添加或删除样本。

• 清除分配给样本孔的方法。

• 向样本孔分配不同的方法。

• 在 Sequence Summary 表格中，将恢复方法分配给序列中的方法。通常，应将关闭方
法分配为恢复方法。

如需详细说明，请参阅文档：《软件帮助系统》。

6. 如有必要，编辑 Sequence Summary 表格中的信息。

注释: 每个序列的方法名称各不相同。

图 3-1 Sequence Summary 表格：CE-SDS 测试序列

方法和序列
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7. 要查看运行的详细信息，在该运行对应的行中单击 +。

图 3-2 Sequence Summary 表格展开

8. 如有必要，更改 Sample Id 和 Data File 列中的信息。

9. 要查看样本孔板和试剂孔板布局，打开 Plates Layout 选项卡。如有必要，更改 Reagent
Plate 中的试剂位置。

10. 要保存序列，单击 SAVE，然后添加所需的信息。

注释: 如果存在错误，则 SAVE 按钮不可用。解决 Validation 窗格中的所有错误，然后单
击 SAVE。

11. （可选）要打印样本孔板和试剂孔板布局，请执行以下操作：

a. 单击 PRINT。
Print Preview 对话框随即打开。

b. 单击 Plate Layout Report，然后单击 Print。

c. 选择打印选项，然后单击 OK。
随即打印报告。

d. 单击关闭框，即右上角的 ×。
Print Preview 对话框随即关闭。

方法和序列
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制备样本 4
蛋白质的还原状态和非还原状态对比能提供重要的结构信息。本部分包括关于制备还原和非还
原标准品和样本的说明。

制备标准品
根据分析的目标，不同的标准品可能适合。使用适合分析的标准品。

制备还原 MW Size Standard
此标准品在还原条件下制备，以中断或防止通过二硫键形成的任何蛋白质聚集。

注释: 下面的说明提供了用于一份样本的量。

1. 充分混合 MW Size Standard，然后在标准微量离心机中将瓶旋转几秒钟。

2. 向 0.5 mL 微量离心管中添加 10 µL 的 MW Size Standard。

3. 向微量离心管中添加 85 µL 的 SDS-MW Sample Buffer。

4. 向微量离心管中添加 2 µL 的 10 kDa Internal Standard。

5. 在通风橱内，向微量离心管中添加 5 µL 的 2-巯基乙醇。

6. 用封口膜密封瓶盖，使用漩涡混合器充分混合，然后在 70 °C 的水浴中加热混合物
10 分钟。

7. 在离心机中在 300 g 的条件下将试管旋转 1 分钟。

8. 从水浴中将瓶取出，静置最少 3 分钟，以使溶液冷却到室温。

标准品可保持稳定大约 24 小时。

9. 向样本孔板的孔中添加 100 µL 制备的标准品。

对于样本孔板上包含样本的色谱柱，确保出口孔板上相应的色谱柱中有 2.0 mL 的 CE-
SDS Gel Buffer。

10. 在板上覆盖一层罩膜，然后使用离心机在 30 g 的条件下旋转样本孔板 4 分钟，以清除孔
底部的任何气泡。

制备 IgG Control Standard
对于免疫球蛋白制剂的分析，可以使用 SCIEX IgG Control Standard 作为标准品。该标准品
可以在还原或非还原条件下制备。

制备还原 IgG Control Standard

注释: 下面的说明提供了用于一份样本的量。

1. 制备 IgG Control Standard。

制备样本
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a. 如果是初次运行，请从冰箱中取出一瓶 IgG Control Standard，置于室温下完全解
冻。

b. 使用漩涡混合器粗略混合几秒钟，然后将溶液分成 95 μL 的等份。

c. 预留一份，然后将其余等份储存在 –35 °C 至 –15 °C 的条件下。

2. 使用一份 95 μL 的 IgG Control Standard 等份。如果已冷冻，使用前在室温下解冻。

3. 向 IgG 瓶中添加 2 µL 的 10 kDa Internal Standard。

4. 在通风橱内向 IgG 瓶中添加 5 µL 的 2-巯基乙醇。

5. 盖好瓶盖，然后使用漩涡混合器充分混合。

6. 使用离心机在 300 g 的条件下将瓶旋转 1 分钟。

7. 用封口膜密封瓶盖，然后在 70 °C 的水浴中加热混合物 10 分钟。

8. 从水浴中将瓶取出，静置最少 3 分钟，以使溶液冷却到室温。

9. 向样本孔板的孔中添加 100 µL 制备的标准品。

10. 在板上覆盖一层罩膜，然后使用离心机在 30 g 的条件下旋转样本孔板 4 分钟，以清除孔
底部的任何气泡。

制备非还原 IgG Control Standard
在制备非还原 IgG Control Standard 之前，制备 250 mM 碘乙酰胺 (IAM) 溶液。请参阅以下章
节：制备 250 mM Iodoacetamide Solution。

制备 250 mM Iodoacetamide Solution

1. 称取 46 mg 碘乙酰胺 (IAM)，将其添加到 1.5 mL 微量离心瓶中。

2. 添加 1 mL 的 CE Grade Water 以获得浓度为 46 mg/mL 的溶液。

3. 用盖密封瓶，然后混合该溶液，直到固体完全溶解。

4. 不使用时，将溶液放在暗处。
碘乙酰胺溶液在室温下可稳定约 24 小时。

制备非还原 IgG Control Standard

注释: 下面的说明提供了用于一份样本的量。

1. 制备 IgG Control Standard。

a. 如果是初次运行，请从冰箱中取出一瓶 IgG Control Standard，置于室温下完全解
冻。

b. 使用漩涡混合器粗略混合几秒钟，然后将溶液分成 95 μL 的等份。

c. 预留一份，然后将其余等份储存在 –35 °C 至 –15 °C 的条件下。

2. 使用一份 95 μL 的 IgG Control Standard 等份。如果已冷冻，使用前在室温下解冻。

3. 向 IgG Control Standard 试管中添加 2 µL 的 10 kDa Internal Standard。

4. 添加 5 µL 的 250 mM IAM 溶液。

制备样本
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5. 盖好瓶盖，然后使用漩涡混合器充分混合。

6. 在离心机中以 300 g 的条件将瓶旋转 1 分钟。

7. 用封口膜密封瓶盖，然后在 70 °C 的水浴中加热混合物 10 分钟。

8. 从水浴中将瓶取出，静置最少 3 分钟，以使溶液冷却到室温。

标准品可保持稳定大约 24 小时。

9. 在瓶中混合溶液，然后使用离心机在 300 g 的条件下将瓶旋转 1 分钟。

10. 向样本孔板添加 100 µL 制备的标准品。

对于样本孔板上包含样本的色谱柱，确保出口孔板上相应的色谱柱中有 2.0 mL 的 CE-
SDS Gel Buffer。

11. 在板上覆盖一层罩膜，然后使用离心机在 30 g 的条件下旋转样本孔板 4 分钟，以清除孔
底部的任何气泡。

制备样本
使用下面的程序制备一份样本。

建议蛋白质浓度

加入 SDS-MW Sample Buffer 后，总蛋白质浓度必须为 0.2 mg/mL 至 2 mg/mL。为获得最佳
结果，建议蛋白质浓度为 1 mg/mL。如果蛋白质浓度过高，可能会导致 SDS 结合不足，从而
产生宽峰和低分辨率。如果蛋白质浓度过低，可能出现低信号。

此检测的信号强度和分辨率对蛋白质样本中的盐浓度也很敏感。如果盐浓度过高，则可能出现
低信号和峰拖尾。请参阅以下章节：对蛋白质样本进行缓冲剂置换。

制备还原样本

注释: 下面的说明提供了用于一份样本的量。

1. 用 SDS-MW Sample Buffer 将样本稀释至总体积为 95 µL，以得到 0.2 mg/mL 至
2 mg/mL 的最终蛋白质浓度。

注释: 确保将不超过 45 µL 的样本添加到 SDS-MW 样本缓冲剂中。如果需要的量超过
45 µL，则在使用缓冲剂稀释之前浓缩样本。

2. 向样本微量离心管中添加 2 µL 的 10 kDa Internal Standard。

3. 在通风橱内，向微量离心管中添加 5 µL 的 2-巯基乙醇。

4. 盖好微量离心管盖，然后使用漩涡混合器充分混合。

5. 使用离心机在 300 g 条件下将试管旋转 1 分钟。

6. 用封口膜密封瓶盖，然后在 70 °C 条件下加热 10 分钟。

注释: 如果该蛋白质在高温下稳定，则可在 100 °C 下加热 3 分钟。

7. 从水浴中将瓶取出，静置最少 3 分钟，以使溶液冷却到室温。

制备样本
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8. 混合样本试管，然后使用离心机在 300 g 的条件下旋转 1 分钟。

9. 向样本孔板添加 100 µL 制备的样本。

对于样本孔板上包含样本的色谱柱，确保出口孔板上相应的色谱柱中有 2.0 mL 的 CE-
SDS Gel Buffer。

10. 在板上覆盖一层罩膜，然后使用离心机在 30 g 的条件下旋转样本孔板 4 分钟，以清除孔
底部的任何气泡。

制备非还原样本

制备非还原样本之前，制备 250 mM 碘乙酰胺 (IAM) 溶液。请参阅以下章节：制备 250 mM
Iodoacetamide Solution。IAM 溶液在制备样本时用作烷化剂，可降低蛋白质部分自动还原所
造成的异质性。

在非还原条件下，样本必须在高温下加热以增加 SDS 结合。但是，高温可能导致碎裂和聚
集，这可能会造成样本分析中产生伪影。SCIEX 建议采用烷基取代步骤，以最大程度减少温
度造成的伪影。SCIEX 还建议对非还原样本使用低 pH SDS 样本缓冲剂之一。实践证明，
Low pH Phosphate SDS Sample Buffer 减少热诱发伪影的效果优于 SDS-MW Sample
Buffer。

注释: 下面的说明提供了用于一份样本的量。

1. 用 SDS-MW Sample Buffer 将样本稀释至总体积为 95 µL，以得到 0.2 mg/mL 至
2 mg/mL 的最终蛋白质浓度。

注释: 确保将不超过 45 µL 的样本添加到 SDS-MW 样本缓冲剂中。如果需要的量超过
45 µL，则在使用缓冲剂稀释之前浓缩样本。

2. 向样本微量离心管中添加 2 µL 的 10 kDa Internal Standard。

3. 在通风橱内，将 5 µL 的 250 mM IAM 溶液加入样本管。

4. 使用离心机在 300 g 条件下将瓶旋转 1 分钟。

5. 使用封口膜密封瓶。

6. 在 70 °C 的水浴中加热混合物 10 分钟。

7. 从水浴中将瓶取出，静置最少 3 分钟，以使溶液冷却到室温。

8. 向样本孔板添加 100 µL 制备的样本。

对于样本孔板上包含样本的色谱柱，确保出口孔板上相应的色谱柱中有 2.0 mL 的 CE-
SDS Gel Buffer。

9. 在板上覆盖一层罩膜，然后使用离心机在 30 g 的条件下旋转样本孔板 4 分钟，以清除孔
底部的任何气泡。

对蛋白质样本进行缓冲剂置换
此分析的信号强度和分辨率对蛋白质样本中的盐浓度很敏感。如果盐浓度高于 1× 磷酸盐缓冲
盐水 (PBS)，则可能会出现低信号和峰拖尾。使用本程序中的步骤进行缓冲剂置换。

制备样本
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注释: 有关使用其他制造商的装置进行的脱盐或缓冲剂置换程序，请参阅该制造商的用户指
南。

注释: 对于 IgG 样本，不要使用 MicroCon-30kDa 过滤器，因为它会过滤掉 IgG 样本中的游离
轻链 (25 kDa)，导致纯度结果偏移或不准确。

1. 将 1 mL 的蛋白质样本加入合适的离心过滤装置。

• 对于 IgG 样本，使用 Microcon-10kDa 离心过滤装置。

• 对于其他蛋白质，使用 Amicon Ultra-4 离心过滤装置。

2. 使用离心机在 4,000 g 条件下旋转样本 15 分钟。

3. 添加 2 mL 的 SDS-MW Sample Buffer，然后使用离心机在 4,000 g 条件下旋转样本
25 分钟。

4. 小心地将离心过滤装置倒置在新瓶中，然后使用离心机在 1,000 g 条件下旋转该瓶
3 分钟。

蛋白质溶液将收集在小瓶中。

5. 将收集的蛋白质溶液转移至适当的试管中。

6. 测定蛋白质浓度。

7. 添加 SDS-MW Sample Buffer，使最终浓度为 1 mg/mL。

使用低 pH 样本缓冲剂

注释: SCIEX 带有两种不同的低 pH 样本缓冲剂，即 Low pH SDS Sample Buffer（Tris，pH
6.8）（包含在 CE-SDS Protein Analysis 试剂盒中）和可选的 Low pH Phosphate SDS
Sample Buffer (pH 6.5)。

有些样本在 pH 值较低的样本缓冲剂中更加稳定。如果分离特征随着每次重复运行变化，则表
明蛋白质在 pH 值为 9 的 SDS-MW Sample Buffer 中可能不稳定。使用低 pH 缓冲剂再次制备
样本。

要使用任何一种低 pH 样本缓冲剂，按照前面所述的方法制备样本，但是将 SDS-MW Sample
Buffer 替换为 Low pH SDS Sample Buffer (pH 6.8) 或 Low pH Phosphate SDS Sample
Buffer (pH 6.5)。

由于低 pH 值缓冲剂的离子强度增加，我们建议升高进样电压或时长以更改分离方法，从而防
止任何信号丢失。根据待分析样本调整分离时间。或者，在分离方法中使用压力进样。

制备样本
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准备 BioPhase 8800 系统 5
使用本节中的程序准备 BioPhase 8800 系统以采集数据。

本节中的程序假定系统已正确安装并初始化。

提示! 为了节省时间，在启动运行之前 30 分钟开启光源，以使其预热。

加载试剂入口和出口孔板

注释: 为防止出现气泡，切勿摇晃或用力混合凝胶缓冲剂。气泡可能会造成分离问题。

1. 按照试剂孔板布局将试剂添加到试剂入口和出口孔板。请参阅图：图 D-4。

使用下表中的体积。

注释: 对于出口孔板，确保倒角位于右上方，然后仅填充孔板左侧的孔。右侧的孔用于溢
流，必须保持为空。

表 5-1 试剂入口和出口孔板的试剂

孔板 试剂

入口孔板 800 µL/孔

出口孔板 • 每个孔 2.8 mL 试剂，用于分离或等待操作

• 每个孔 1.5 mL 的 CE Grade Water，用于废液位置

2. 在板上覆盖一层罩膜。

小心: 潜在的系统损坏。切勿使用加热孔板密封剂涂抹密封件。热量可能会损坏孔板表
面，从而导致压力系统出现问题。

注释: 只有来自 USA Scientific 的 X-Pierce 膜经过了验证。如果使用不同的膜，则在使用
之前进行测试。

3. 将孔板放进吊桶式转头，然后在 30 g 的条件下旋转 4 分钟。确保吊桶保持平衡。

小心: 潜在的错误结果。切勿将未通过旋转除去气泡的孔板装入系统。存在气泡可能会导
致分离失败。

4. 确保孔板中不存在气泡。如果存在气泡，则使用更高的相对离心力 (RCF) 再次旋转孔板。

对于试剂孔板，最大 RCF 为 1,000g。对于样本孔板，最大 RCF 为 375g。

5. 在前面板上，触摸 Eject Reagent。

准备 BioPhase 8800 系统
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图 5-1 Eject Reagent 按钮

孔板室打开。

6. 撕去孔板上的罩膜。

小心: 潜在的系统损坏。取下罩膜之前，切勿将板装入系统。运行期间若存在罩膜，则可
能会损坏毛细管尖端。

7. 如果孔板室已包含试剂孔板，则将这些试剂孔板取出。

8. 对准试剂入口孔板中的凹槽与弹片，然后将孔板放进孔板托架中。

9. 确保试剂出口孔板的倒角位于左上方，然后将孔板放进孔板托架背面。

10. 触摸 Load Reagent。

图 5-2 Load Reagent 按钮

孔板室关闭。

加载样本入口和出口孔板
1. 按照样本孔板布局将样本添加到样本入口孔板中。请参阅图：图 D-3。

推荐样本量为 100 µL。

最小样本量为 50 µL。 最大样本量为 200 µL。

2. 为了防止损坏毛细管，如果存在并非每个孔中都有样本的列，则向每个空孔中添加 100
µL 至 200 μL 样本缓冲剂。

如果某列中没有样本，则孔可以保留为空。

3. 按照样本孔板布局将试剂添加到样本出口孔板。请参阅图：图 D-3。
最大体积为 2.0 mL。

使用下表中的体积。

对于含有样本的样本孔板上的任何列，确保出口孔板上相应的列含有 2.0 mL 的分离凝
胶。

注释: 对于出口孔板，确保倒角位于右上方，然后仅填充孔板左侧的孔。右侧的孔用于溢
流，必须保持为空。

准备 BioPhase 8800 系统
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表 5-2 样本出口孔板的试剂

孔板 试剂

出口孔板 • 2.0 mL 凝胶缓冲剂/孔

4. 在板上覆盖一层罩膜。

小心: 潜在的系统损坏。切勿使用加热孔板密封剂涂抹密封件。热量可能会损坏孔板表
面，从而导致压力系统出现问题。

注释: 只有来自 USA Scientific 的 X-Pierce 膜经过了验证。如果使用不同的膜，则在使用
之前进行测试。

5. 将孔板放进吊桶式转头，然后在 30 g 的条件下旋转 4 分钟。确保吊桶保持平衡。

小心: 潜在的错误结果。切勿将未通过旋转除去气泡的孔板装入系统。存在气泡可能会导
致分离失败。

6. 确保孔板中不存在气泡。如果存在气泡，则使用更高的相对离心力 (RCF) 再次旋转孔板。

对于试剂孔板，最大 RCF 为 1,000g。对于样本孔板，最大 RCF 为 375g。

7. 在前面板上，触摸 Eject Sample。

图 5-3 Eject Sample 按钮

孔板室打开。

8. 撕去孔板上的罩膜。

小心: 潜在的系统损坏。取下罩膜之前，切勿将板装入系统。运行期间若存在罩膜，则可
能会损坏毛细管尖端。

9. 如果孔板室已包含样本孔板，则将这些样本孔板取出。

10. 调整样本孔板的方向，使板上的对准槽口对准凸舌，然后将板放进板托架中。

11. 调整样本出口孔板的方向，使倒角位于左上方，然后将板放进板托架背面。

12. 触摸 Load Sample。
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图 5-4 Load Sample 按钮

孔板室关闭。

检查毛细管卡盒

警告! 刺伤危险。卡盒要轻拿轻放。毛细管的尖端特别锋利。

小心: 潜在的系统损坏。切勿让凝胶缓冲剂或其他试剂在电极、毛细管端、卡盒密封垫或卡盒
主体上结晶。电解质盐晶体或沉淀会导致毛细管堵塞、压力密封不当、样本进样时发生错误、
出现电弧或漏电。

1. 使用之前检查电极、毛细管尖端、卡盒密封垫和卡盒主体接口。

2. 如果卡盒外部存在凝胶或液体，则使用湿无绒实验室擦拭巾清洁卡盒。清洁之后，确保干
燥卡盒。

注释: 切勿使用肥皂或洗涤剂清洁卡盒。

3. 如果毛细管尖端堵塞，则执行此操作：

a. 使用 CE Grade Water 清洗毛细管入口。

b. 使用无绒实验室擦拭巾沿着朝外的方向小心地擦拭毛细管入口。

4. 使用放大镜检查毛细管窗口两侧。如果存在绒毛或其他颗粒，则使用电子级压缩空气快速
吹扫以将其除去。切勿使用水或其他液体清洁毛细管窗口。

小心: 潜在的系统损坏。切勿使用甲醇或丙酮等有机溶剂清洁毛细管窗口。有机溶剂会溶
解胶粘剂，毛细管窗口的残留物可能会影响检测器。

5. 用乙醇或异丙醇蘸湿无绒擦拭巾或棉签，然后擦拭芯片表面。安装卡盒之前晾干芯片。

安装卡盒

警告! 刺伤危险。卡盒要轻拿轻放。毛细管的尖端特别锋利。

警告! 夹手危险。当打开前面板时，注意不要把手指放在前面板左侧。

小心: 潜在的系统损坏。确保在系统中安装卡盒之前安装试剂板。否则可能会损坏卡盒。

1. 如果卡盒存放在冰箱中，则让卡盒平衡到室温大约 30 分钟，以防止在系统中发生冷凝。

准备 BioPhase 8800 系统
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2. 从湿化托盘中取出卡盒。

3. 使用一次性实验室擦拭巾擦干卡盒主体，以防止产生电弧。

4. 将卡盒底部翻转朝上。

5. 使用一次性无绒实验室擦拭巾非常轻地擦干毛细管和电极从卡盒中显露出来的区域。切勿
干扰密封垫。

图 5-5 卡盒底部

项目 描述

1 出口孔板密封垫

2 入口孔板密封垫

6. 如果试剂孔板未安装到系统中，则安装它们。请参阅以下章节：加载试剂入口和出口孔
板。

7. 打开前面板，然后将卡盒放入系统。

8. 关闭前面板，然后触摸 EJECTED 以锁定卡盒。
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图 5-6 EJECTED 按钮

如果超出了卡盒运行寿命，则会在前面板日志中添加警告消息。要查看警告消息，请触摸

前面板状态区域的 。该卡盒仍可使用，也可安装新卡盒。

系统移动试剂孔板，使毛细管进入色谱柱 1 上方的位置，然后升高孔板，使毛细管末端浸
入 CE Grade Water。

9. 检查前面板上的冷冻剂液位。如有必要，向系统的加注口中添加冷冻剂。

请参阅文档《操作员指南》中的“添加毛细管卡盒冷冻剂”章节。
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运行样本 6
从前面板启动序列
要使用 Waters Empower™ 软件，请参阅以下章节：启动样本组方法。

1. 如果需要，装载卡盒、试剂孔板和样本孔板。

2. 在前面板上，触摸 RUN SEQUENCE。

图 6-1 RUN SEQUENCE 按钮

3. 在 Projects 窗格中，触摸 CE-SDS Project。

4. 在 Available Sequences 窗格内，触摸列表中相应的序列。

• 对于还原样本，单击 CE-SDS 测试序列。

• 对于非还原样本，单击非还原 CE-SDS 序列。

• 对于使用低 pH 样本缓冲剂制备的样本，单击低 pH 样本缓冲剂 CE-SDS 序列。

5. （可选）要查看方法、样本孔板或试剂孔板的详细信息，触摸 Method 列中的任何位置。
要隐藏详细信息，再次触摸该列或框。

6. 触摸 Run Sequence。

图 6-2 Run Sequence 按钮

如果序列包含与系统配置不兼容的方法，则不会启用 Run Sequence。

数据文件保存在序列中指定的位置。

如果在运行期间出错，并且序列中存在错误恢复方法，则 BioPhase 8800 系统将启动该
错误恢复方法。

在运行过程中，可执行各种操作。请参阅以下章节：在 BioPhase 8800 前面板中监测运
行。

当运行完成时，Run Completed 对话框打开。
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图 6-3 Run Completed 对话框

7. 触摸 OK 以关闭 Run Completed 对话框。

8. 根据需要储存卡盒。请参阅以下章节： 运行后储存卡盒。

在 BioPhase 8800 前面板中监测运行
使用此程序监测序列进度，然后根据需要暂停或停止序列。

要使用 Waters Empower™ 软件，请参阅以下章节：在 Waters Empower™ 软件中监测运行。

注释: 下图中显示的序列用于图解目的。它不显示 CE-SDS Protein Analysis 试剂盒的序列。

1. 监测检测器和电流的迹线，以确保序列正在运行。

2. 如果检测到问题，则触摸  停止运行，然后在 Warning 对话框中，触摸下列选项之
一：

• Yes：触摸后启动错误恢复方法（如果已指定）。

• No：如果未指定错误恢复方法则触摸此选项。

注释: 停止运行可能会导致样本或试剂损失并损坏卡盒。

• 要继续运行，请触摸 Cancel。

图 6-4 Warning 对话框
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小心: 潜在的系统损坏。如果运行停止且不恢复运行，则在存储卡盒之前使用关闭方法冲
洗毛细管。如果不冲洗毛细管，电解质盐晶体或沉淀会聚积并导致毛细管堵塞、压力密封
不当、样本进样时发生错误、出现电弧或漏电。

小心: 潜在的系统损坏。开始运行前，确保清空或更换出口板，以防止试剂溢出以及可能
的仪器损坏。

小心: 潜在的错误结果。在重新开始运行之前，准备新试剂板。如果运行已停止，则可能
是没有足够的试剂可用于完成该运行。

小心: 潜在的错误结果。如果样本在系统内放置的时间超过 24 小时，则在再次开始运行之
前将其丢弃。样本的性能可能已下降。

3. 如果出错，则在显示的错误对话框中触摸 OK。
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图 6-5 运行序列错误

注释: 该 显示 Rinse 操作中的错误。Rinse 操作上方行中的灰色阴影表示该操作正
在进行或已完成。

4. 查看错误：

a. 触摸前面板日志的 Events 选项卡中的 。

b. 触摸 Initialize System 以重新初始化系统，然后将系统状态更改为空闲。
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图 6-6 序列错误事件日志

5. 如有必要，触摸 Pause Run 以暂停运行。
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图 6-7 运行正在进行的序列

6. 要继续运行，请触摸 Cancel Pause。
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图 6-8 重新启动运行序列

7. 要在采集时查看数据，触摸功能区中的 。

注释: 下图中的数据用于图解目的。它不显示使用 CE-SDS Protein Analysis 试剂盒制备
的样本的结果。
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图 6-9 毛细管视图

8. （可选）要放大数据，请执行以下操作：

a. 触摸 Overlay。

b. 使用两根手指放大或缩小以查看电泳图谱。

c. 使用手形图标移动电泳图谱。

注释: 缩放功能仅可用于检测器和电流的叠加视图。
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图 6-10 放大或缩小

9. 确保运行完成时显示了消息 Sequence run Completed Successfully。在该对话框

中，触摸 OK。

图 6-11 运行已完成
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废物处置

警告! 生物危害或有毒化学品危险。在处置化学品、卡盒、试剂孔板、样本孔板
和残留的制备样本时，请遵照当地规定。其可能包含限用化合物和生物危害性试
剂。

运行后储存卡盒

警告! 刺伤危险。卡盒要轻拿轻放。毛细管的尖端特别锋利。

卡盒储存时间不超过三天

1. 如果序列或样本组方法中未包括关闭方法，则使用该关闭方法清洁毛细管。
该关闭方法用 CE-SDS Gel Buffer 填充毛细管。

2. 将卡盒在系统中储存最多三天，并且毛细管端应浸入 CE Grade Water 中。

注释: 如果卡盒不使用的时间达到三小时或更久，则在执行分离之前应运行调节方法。

卡盒储存时间超过三天

1. 如果序列或样本组方法中未包括关闭方法，则使用该关闭方法清洁毛细管。
该关闭方法用 CE-SDS Gel Buffer 填充毛细管。

2. 在 80 psi 的压力下使用 CE Grade Water 冲洗毛细管 10 分钟以进行清洁。

3. 在 BioPhase 8800 系统前面板的功能区中，触摸  (Loaded)，然后等待大约一
分钟。

等到冷冻剂回到冷冻剂储液瓶，然后再取出卡盒。

4. 从系统中取出卡盒，然后将其储存在 2 °C 至 8 °C 条件下，毛细管端应浸入 CE Grade
Water 中。

注释: 定期更换托盘中的 CE Grade Water，以免托盘中出现微生物生长。

储存后准备卡盒

• 如果卡盒未使用的时间超过一天，或者已长时间储存，则使用 CE-SDS 调节方法调节毛细
管。

注释: 为了防止产生电弧，在将卡盒安装到系统中之前，小心地拭去电极和卡盒主体四周的水
分。
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分析数据 7
使用分析参数文件分析数据

注释: 如果要使用 Waters Empower™ 软件采集数据，则此程序不适用。

下面的说明解释了如何通过 BioPhase Analysis 软件使用分析参数文件分析数据。分析参数文
件包含对峰进行积分和识别数据中的峰需要的所有信息。

注释: 本程序假定您熟悉 BioPhase 软件。如需详细说明，请参阅文档：《软件帮助系统》。

注释: 此程序中的分析参数文件只是示例。这些参数可能并非对所有数据文件都是最佳。

1. 在 BioPhase 软件的主页上，单击 Data Analysis。
BioPhase Analysis 软件主窗口打开。

2. 单击 File > Open，选择要分析的数据文件，然后单击 Open。

3. 在 Project 工具栏中，单击 ，导航到 CE-SDS Reduced IgG Analysis，然后单击
Open。
CE-SDS Reduced IgG Analysis 文件是该分析的起点。

4. 右键单击 ，然后选择 Apply & Analyze (all)。

软件将 Integration、Library 和 Post Analysis 选项卡中的所有参数应用于所有数据文件，
然后显示结果。

在 Files 窗格中，文件名显示为红色以指示数据已分析。已识别峰的数量显示在 Peaks 列
中。

在 Data 窗格中，分析结果显示在图形下方的表格中。在表格顶部，显示 RMS Noise、P-
P Noise 和 Drift。在图形中，基线显示为红色，阈值显示为灰色水平线。在分析中识别的
任何峰的峰起点为蓝色标记，峰顶为红色标记，峰终点为绿色标记。

图形中的峰具有以下阴影：

• 绿色：峰对应于 Library 选项卡上 Marker Table 中的峰。

• 蓝色：峰对应于 Library 选项卡上 Peak Table 中的峰。

• 红色：这种峰不是命名峰。

请参阅以下章节：检查结果。

5. 在图形上显示峰名称。

a. 右键单击 。
Information Setup 对话框随即打开。

b. 选择 Name 以及要在图形上查看的任何其他信息，例如 MT，然后单击 OK。
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c. 单击 。

峰名称显示在图形上。请参阅以下章节：检查结果。

该名称是分析参数文件的组成部分。要使用不同的名称，请参阅文档：《《软件帮助系
统》》中的“识别峰”章节。

6. 单击文件列表下方的 Files 窗格，然后按下 Up 和 Down 箭头键以在 Data 窗格中查看每
个文件的数据。

如果需要，在图形的区域上拖动以放大显示，从而查看该区域中已识别峰的细节。

提示! 为了防止需要在每个数据文件上放大，单击  以对所有数据文件应用相同的缩放
设置。

7. 确保积分令人满意。调整积分参数，然后按需要再次分析数据。

8. 检查 Marker Table 和 Peak Table 中的峰的电泳图谱。

a. 对于 Marker Table 和 Peak Table 中的每个峰，确保在图形中标记了正确的峰。

b. 根据需要，调整 Marker Table 中的 MT 和 Peak Table 中的 MT（或 Cal MT）。

c. 根据需要，调整 Tol 和 Crit，然后单击 。

• Tol 是匹配图形中的峰与 Marker Table 或 Peak Table 中的峰时的公差。键入 % 以
百分比的形式使用公差。

• Crit 是需要匹配的峰特征。

• Ctr：匹配离范围中央最近的峰。

• Ht：匹配范围中最高的峰。

• Area：匹配范围中最大的峰。

d. 当峰分布令人满意时，右键单击 ，然后选择 Apply & Analyze (all)。

软件会将更改应用于所有数据文件。

9. （可选）在 Project 工具栏中，单击 ，键入名称，选择位置，然后单击 OK。
分析参数保存到文件中供以后使用。

10. （可选）在 File 工具栏中，右键单击 ，然后选择 Print (all)。
Data 窗格的内容使用当前报告模板打印。 如需关于创建报告模板的说明，请参阅以下文
档中的“配置报告”章节：《操作员指南》。

11. 在 File 工具栏中，右键单击 ，然后选择 Save (all)。
对结果（包括分析参数）的所有更改都将保存到数据文件中。

12. 在 File 工具栏中，右键单击 ，然后选择 Close (all)。
所有数据文件都将关闭。
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检查结果

图 7-1 SDS-MW Sample Buffer 中的非还原 IgG 样本

图 7-2 SDS-MW Sample Buffer 中的还原 IgG 样本
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图 7-3 Low pH SDS Sample Buffer 中的 NIST IgG 样本

图 7-4 SDS-MW Sample Buffer 中的 MW Size Standard

审查 Overlay 选项卡上的结果
Overlay 选项卡显示所选数据文件的图形。此选项卡包含所选数据文件的统计信息，以及系统
适用性报告。

注释: 本节不阐述系统适用性功能。有关系统适用性的信息，请参阅文档：《操作员指南》。
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1. 打开一组数据文件以及相应的分析参数文件，然后分析数据。如有需要，调整分析参数，
直到结果令人满意。

2. 在 Files 窗格中，单击 ，然后打开 Overlay 选项卡。

图 7-5 Overlay 选项卡

图形中的迹线颜色对应于 Files 窗格中的文件名旁边的圆圈中的颜色。

较粗的线对应于 Files 窗格中所选文件的迹线。

3. 上下移动图形右侧的滑块以调整迹线。

注释: 要以一系列平铺图形的形式查看迹线，将滑块一直移到顶部。

4. 计算 Overlay 选项卡上的所有文件的结果。

图 7-6 Results Table
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项目 描述

1 参考文件

2 分析类型

3 将结果保存到逗号分隔文件

a. 单击 Results Table 标题右侧的列表以选择分析类型。

提供了以下选项：

• Reference - All：在 Results Table 中，显示参考文件中的将出现在所有其他数据
文件中的每个峰的统计信息。

• Reference - Peak Table：在 Results Table 中，显示参考文件中的将出现在所有
其他数据文件中的每个命名峰的统计信息。

• Named Peaks：在 Results Table 中，显示任何数据文件中的所有命名峰的统计信
息。

• All Data (not displayed)：计算但不显示所有数据文件中的所有峰的统计信息。

• System Suitability：如果在分析数据时启用了系统适用性，则显示系统适用性报
告。

如果峰顶的迁移时间匹配度在 5% 以内，则可认为数据文件中的峰与参考文件中的峰
匹配。

b. 单击左侧的列表，然后选择参考文件。

参考文件是用于与所有其他文件进行比较的文件。

只有 Reference - All 和 Reference - Peak Table 分析使用参考文件。

Results Table 更新，以显示所选分析或系统适用性报告。

如果选择了 All Data (not displayed)，则 Results Table 为空。要查看结果，单击 Save
以将结果保存为逗号分隔文件，然后在其他程序中打开该文件。

5. （可选）重复第 4 步以使用不同的参考文件或查看不同类型的分析。

6. （可选）单击 Save。
Results Table 将会保存到逗号分隔文本文件。仅保存表格中显示的列。

注释: 要保存系统适用性结果，单击 File > Save Report。结果保存为 PDF 文件。

7. （可选）单击 File > Print。
Overlay 选项卡的内容使用当前报告模板打印。

8. （可选）在 File 工具栏中，右键单击 ，然后选择 Save (all)。
对结果和分析参数所做的所有更改都保存到数据文件中。

9. 在 File 工具栏中，右键单击 ，然后选择 Close (all)。
所有数据文件都将关闭。
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制定接受度标准的要领
为了按照 SOP 与此试剂盒共用或其他目的而创建的接受度标准应基于体现关键样本质量的分
离和属性质量固有的参数。凝胶和毛细管批次之间的差异以及不同的系统可能会导致绝对迁移
时间的差异。

峰纯度（表示为峰的校正面积百分比）、峰分辨率和相对迁移时间（使用来自 SCIEX 的 10
kDa Internal Standard 或样本中的主峰作为参考标志物）是 CE-SDS 分析中普遍接受的系统
适用性标准。SCIEX 强烈反对使用绝对迁移时间作为接受度标准。

使用 MW Size Standard 估算分子量
要估算未知蛋白质的分子量，可使用 X 轴外部标志物校准功能。请参阅以下章节：使用外部标
志物创建校准曲线。

注释: 如果未知样本中存在 10 kDa Internal Standard，则使用 10 kDa Internal Standard 作为
参考峰来校正迁移时间变化，并提高估计分子量的准确性。

1. 使用 MW Size Standard 完成运行。

2. 在 BioPhase Analysis 软件中，使用 MW Size Standard 的迁移时间和分子量创建校准曲
线。

3. 对数据应用校准曲线。如果显示，未知蛋白质的估计分子量显示为 Results Table 中和图
形上的批注中的 Cal MT。

SCIEX 建议在 24 次运行之后再次校准外部校准曲线。要再次校准曲线，使用 MW Size
Standard 再运行一次，然后使用运行的结果更新每个标准品的迁移时间。

使用外部标志物创建校准曲线

使用此功能从一组外部标志物生成 X 轴的校准曲线。如果外部标志物组和未知样本中都存在参
考标志物，则可使用参考标志物校正迁移时间中的变化。

1. 设置校准曲线的参数。

a. 打开包含从标准物的分离获得的结果的数据文件。

b. 对数据进行积分。

c. 在 Marker Table 中，指定 MW Size Standard 的峰作为标志物。

d. 对于每个标志物，在相应的 Cal MT 单元格中键入分子量。

e. 选择 External markers，它位于选项卡右侧的 Marker Table 上方。

f. 键入 X-axis Name 和 Units。

g. 在 Fit Type 列表中，选择校准曲线的类型。

2. （可选）设置适当的参数，用于匹配参考峰与包含未知物的样本的数据中的峰。

a. 在 Marker Table 中选择 Ref 作为参考峰。

b. 单击 。

c. 在 Ref MT 字段中，键入包含未知物的样本的数据中的参考峰的预计迁移时间。
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d. 在 Tol 字段中，键入公差。

e. 在 Crit 列表中，选择条件。

f. 单击 OK。

如果选择了参考峰，则通过将迁移时间乘以 Ref Peak MT（未知物）与 Ref Peak MT
（外部标志物组）之比来校正校准曲线中的迁移时间。尽管迁移时间存在变化，但这样能
够更准确地确定 Cal MT。

3. 单击 ，然后检查图形和 Results Table 以确保 Cal MT 值正确。

4. 单击 Show Graph，并确保来自 Marker Table 的数据点与校准曲线拟合。
校准曲线基于 Marker Table 中的 MT 和 Cal MT 值。

5. 单击 ，然后将参数保存到分析参数 (dana) 文件。

6. 单击 File > Open，然后选择要分析的文件。

7. 打开在第 5 步中创建的分析参数文件。

8. 右键单击 ，然后选择 Apply & Analyze (all) 或 Apply & Analyze (checked)。
如果外部标志物组和未知数据中都存在参考峰，则检查结果。如有必要，单击 ，然后
调整对话框中的 Ref MT、Tol 和 Crit 值，以使未知物中的参考峰出现在迁移时间窗口
内。
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使用 Waters Empower™ 软件运行样
本 8
本节提供了关于结合使用 Waters Empower™ 软件和 BioPhase 8800 driver for Empower™ 与
BioPhase 8800 系统的说明。

导入 BioPhase 软件方法以创建仪器方法

注释: 使用 BioPhase 软件创建的方法随 BioPhase 8800 driver for Empower™ 一起提供。这些
方法也可从 SCIEX 网站下载。请参阅以下章节：下载和配置必需文件（Waters Empower™ 软
件）。

仪器方法还可在 Method Editors for BioPhase System 软件中创建。请参阅以下文档：《操作
员指南》和《软件帮助系统》。

通常，需要三种类型的方法：调节方法、分离方法和关闭方法。对于有些工作流程，还有其他
的方法。

以下方法可用。

• CE-SDS 调节：调节毛细管。

• 分离方法：

• 还原 CE-SDS 分离：用于还原样本。

• 非还原 CE-SDS 分离：用于非还原样本。

• 低 pH 样本缓冲剂分离：用于使用低 pH 样本缓冲剂制备的样本。

• CE-SDS 关闭：在序列结束时清洁毛细管，冲洗毛细管以便储存，然后关闭灯。

使用下列步骤导入 BioPhase 软件方法并创建与 Waters Empower™ 软件配合使用仪器方法和
方法集。为工作流程创建适当的方法和方法集。

1. 在 Waters Empower™ Software Project 窗口中，单击 File > New Method > Instrument
Method。
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图 8-1 Select Desired Chromatography System 对话框

2. 单击要使用的系统，然后单击 OK。

Instrument Method Editor 打开。

3. 单击 Import，然后浏览到调节方法。
该方法在 Instrument Method Editor 窗口中打开，Method Settings 选项卡显示在最前。

注释: 此窗口为只读模式。如果需要更改方法，则保存仪器方法，然后在 Method Editors
for BioPhase System 软件中编辑该方法。请参阅文档《软件帮助》中的“编辑现有的仪器
方法”章节。

图 8-2 仪器方法编辑器中的 Method Settings 选项卡

4. （可选）打开 Method Program 选项卡以查看操作。
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5. 要查看操作的参数，单击表格中的行。
Parameters 窗格更新以显示参数。

图 8-3 仪器方法编辑器中的 Method Program 选项卡

6. 保存调节仪器方法。

a. 单击 File > Save with Method Set。
Save current Instrument Method 对话框随即打开。

b. 在 Name 字段中键入一个名称。

注释: 名称长度必须少于 30 个字符，可以包含字母数字字符、空格以及特殊字符
@、_ 和 %。虽然有些版本的 Waters Empower™ 软件可接受超过 30 个字符和其他
特殊字符，但是如果在 Method Editors for BioPhase System 软件中编辑该方法，这
些字符可能会产生问题。

c. （可选）在 Method Comments 字段中键入信息。

d. 如果出现提示，在 Password 字段中，键入当前用户的 Waters Empower™ 软件密
码，然后单击 Save。

仪器方法和方法集保存到当前项目。

7. 单击 File > Exit。

注释: 导入方法后，Instrument Method Editor 窗口中的 Import 按钮不可用，除非关闭窗
口后再重新打开。

8. 重复第 3 步至第 7 步，以创建其他仪器方法和方法集。
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创建样本组方法
下面的说明可为八个样本创建样本组方法，这是样本孔板每一列中的孔数。

注释: 样本组方法需要方法集。请确保任何必需的仪器方法都是方法集的一部分。

1. 在 Waters Empower™ Software Run Samples 窗口中，单击 BioPhase 8800 >
BioPhase Sample Set Editor。

Method Editors for BioPhase System 软件打开，显示 Sample Set Method Editor 工作
区。

2. 单击 New Sample Set Method。
Sample Set Method Editor 打开，显示 Sample Plate Setup 选项卡。

3. 在 Sample Set Summary 表的第一行中，单击 Method Set Name 单元格，然后选择 CE-
SDS 调节。

4. 在 Sample Plate Layout 窗格中，单击 1。
选择了样本孔板的第一列，Sample Set Summary 表会更新以显示所选的孔。

图 8-4 Sample Plate Layout 窗格

5. 向 Sample Set Summary 表中添加所需样本信息。在第 2 至 9 行中，执行以下操作：

a. 在 Sample Name 单元格中，键入样本的名称。

b. 单击 Method Set Name 单元格，然后从列表中选择还原 CE-SDS 分离或适当的分离
方法。
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提示! 为第 2 行选择方法集后，右键单击并选择 Apply method to all samples in
column 以将该方法分配给所有样本。

6. 在最后一行中，单击 Method Set Name 单元格，然后选择 CE-SDS 关闭。

图 8-5 Sample Set Summary 表

7. 如果显示 Validation 窗格，则单击该窗格以查看错误。单击错误以突出显示错误发生的位
置，然后进行必要的更改。

如果不存在错误，则不显示 Validation 窗格。

8. 保存样本组方法。

a. 单击 SAVE AS。

注释: 如果存在错误，则 SAVE AS 按钮不可用。解决 Validation 窗格中的所有错误，
然后单击 SAVE AS。

Save Sample Set 对话框随即打开。

b. 在 Sample Set Name 字段中键入名称。

注释: 名称长度必须少于 30 个字符，可以包含字母数字字符、空格以及特殊字符
@、_ 和 %。虽然有些版本的 Waters Empower™ 软件可接受超过 30 个字符和其他
特殊字符，但是如果在 Method Editors for BioPhase System 软件中编辑该方法，这
些字符可能会产生问题。

c. （可选）在 Description 字段中键入信息。

d. 单击 Save，然后单击 OK 以确认保存的方法。

样本组方法将保存到 Waters Empower™ 软件数据库中。

9. 要查看、保存或打印孔板布局：

a. 打开 Plate Layouts 选项卡。

b. （可选）单击 PRINT。
Print Preview 窗口随即打开。

c. 根据需要，单击相应的按钮打印或保存孔板布局。
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请参阅文档《软件帮助系统》中的“Print Preview 对话框”章节。

d. 单击关闭框，即右上角的 ×。
Print Preview 对话框随即关闭。

10. 在 Method Editors for BioPhase System 窗口中，单击关闭框，即右上角的 ×。
Method Editors for BioPhase System 软件关闭，显示 Run Samples 窗口。

启动样本组方法
1. 装载卡盒和孔板。请参阅以下章节：准备 BioPhase 8800 系统。

2. 在 Waters Empower™ 软件 Project 窗口中，单击 Tools > Run Samples。

图 8-6 Select Desired Chromatography System 对话框

3. 单击要使用的系统，然后单击 OK。
Run Samples 窗口打开。

4. 配置孔板类型。

a. 单击 Edit > Plates。
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图 8-7 Define Plates for Sample Set Method 对话框

注释: 如果该对话框看上去不像上图，则清除 2790 Layout 复选框。

b. 单击 Plate Type Name 单元格，然后选择 ANSI-96well2mL。
对话框更新，显示孔板图片以及孔板定序模式的按钮。

c. 单击 Plate Layout Position 单元格，然后输入 1。

d. 单击  以指示运行过程中样本孔的检测顺序。

e. 单击 OK 保存更改，然后关闭对话框。

提示! 要永久配置孔板类型，单击 Customize > Defaults，然后单击 Plates，执行第 4.b
步至第 4.e 步，然后单击 OK。

在 Sample Set Method 表中，Vials 列的标题变成 Plate/Well。

5. 单击  (Load Sample Set)。
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图 8-8 Load Samples 对话框

6. 单击 Load using a previously created sample set method，然后单击 OK。

图 8-9 Open an existing sample set method 对话框

7. 单击列表中的 CE-SDS Kit Sample Set Method，然后单击 Open。
该样本组方法在 Samples 选项卡中打开。

8. （可选）将表格配置为仅显示与 BioPhase 8800 系统相关的列。

a. 单击右键，然后选择 Table Properties。
Table Properties 对话框打开。

b. 单击 Hide All，然后清除 Plate/Well、# of Injs、SampleName、Function 和
Method Set / Report or Export Method 的复选框。
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c. 单击 OK。

表格更新，以显示所选的列。

图 8-10 Samples 选项卡

9. 审核样本组方法。确保使用正确的试剂孔板布局。如果需要进行任何更改，则在 Method
Editors for BioPhase System 软件中编辑该方法。对仪器方法或方法集进行的任何更改都
自动传播到样本组方法。

10. 在 Waters Empower™ Software Project 窗口中，单击  (Start)。
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图 8-11 Run Sample Set 对话框

11. 如有必要，编辑 Run Sample Set 对话框中的信息。

a. 如有必要，编辑 Name for this sample set 字段中的信息。

b. （可选）单击 Shutdown Method，然后选择冲洗毛细管的仪器方法。

如果可用，使用 SCIEX 提供的冲洗方法。如果冲洗方法不可用，则创建一个。使用
与样本组方法方法相同的试剂组以及下列参数：

• 压力：50 psi

• 持续时间：2 min

• 入口：水

• 出口：废液

如果系统在运行期间遇到错误，则会执行此仪器方法，然后停止运行。

c. 如有必要，选择 Do Not Run Shutdown Method During User Abort。

d. 单击 Run。

运行开始。在运行过程中，Sample Set Method 窗口中代表正在采集的样本的行中的文本
为红色。

使用 Waters Empower™ 软件运行样本

CE-SDS Protein Analysis 试剂盒 适用于 BioPhase
8800 系统
52/77

应用指南
RUO-IDV-05-8662-ZH-D



小心: 潜在的数据丢失。切勿在运行期间从 BioPhase 8800 driver for Empower™ Direct
Control 窗格发起任何操作，即使系统处于闲置状态也不例外。任何操作都可能会干扰数
据采集。

在 Waters Empower™ 软件中监测运行
使用此程序监测样本组方法的进度，如有必要，还可将其暂停或停止。

注释: Waters Empower™ 软件中的大部分窗格针对色谱法设计。使用下列步骤监测毛细管电泳
分离的进度，忽略 Time Remaining 和 Solvent Required 窗格中的信息。

1. 如果检测到问题，可单击  (Abort) 停止运行。

小心: 潜在的数据丢失。在保存了所有数据之前切勿停止运行。样本组方法出现在下一行
时，即已保存了数据。

注释: 切勿使用 Direct Control 窗格中的 Stop 按钮。该按钮仅作用于从 Direct Control 窗
格启动的功能。

图 8-12 Abort Options 对话框

小心: 潜在的系统损坏。如果运行停止且不恢复运行，则在存储卡盒之前使用关闭方法冲
洗毛细管。如果不冲洗毛细管，电解质盐晶体或沉淀会聚积并导致毛细管堵塞、压力密封
不当、样本进样时发生错误、出现电弧或漏电。

小心: 潜在的系统损坏。开始运行前，确保清空或更换出口板，以防止试剂溢出以及可能
的仪器损坏。

小心: 潜在的错误结果。在重新开始运行之前，准备新试剂板。如果运行已停止，则可能
是没有足够的试剂可用于完成该运行。
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小心: 潜在的错误结果。如果样本在系统内放置的时间超过 24 小时，则在再次开始运行之
前将其丢弃。样本的性能可能已下降。

当运行结束时，Sample Set Method 窗口的所有行中的文本都为红色。

2. 要查看正在采集的数据，在 Direct Control 窗格中单击  (Monitor)。
Trace View 窗口打开，然后数据显示出来。

图 8-13 Trace View 窗口

3. 如有必要，执行任何下述操作：

• 要查看电流、电压或压力，打开左上部相应的选项卡。

• 要查看包含所有毛细管的数据的单个图形，在左下部单击 Overlay。

• 要查看特定毛细管的数据，选择或清除窗口底部的复选框以选择感兴趣毛细管。

• 要查看迹线上任何点的时间和检测器值，单击迹线上的感兴趣位置。

• 要放大数据，确保选择了 Overlay，然后拖动以选择要缩放的区域。也可使用鼠标滚轮
进行缩放。

• 要使数据恢复到原始尺寸，在右下部单击 Reset Zoom。

• 要查看缩放图中的不同区域，右键单击 X 轴或 Y 轴，然后拖动。

4. 如有必要，在右下部单击 Auto Zero。
检测器信号设置为零。
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5. 等到 Abort 按钮 ( ) 从红色变成绿色 ( )。
数据采集与所有数据都已保存的时间之间可能存在延迟。绿色按钮表示所有数据都已保存
的时间。

6. 按照要求处置样本和试剂。请参阅以下章节：废物处置。

7. 根据需要储存卡盒。请参阅以下章节： 运行后储存卡盒。
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故障排除 9
完成每个纠正措施之后，我们建议再次执行分析以确保症状已得到纠正。

症状 可能的原因 纠正措施

未检测到卡盒错误 1. 卡盒上的 ID 芯片不干净。

2. 系统上的触销不干净。

3. BioPhase 8800 系统固件不
是最新。

1. 用乙醇或异丙醇蘸湿无绒擦拭
巾或棉签，然后擦拭 ID 芯片表
面。安装卡盒之前晾干 ID 芯
片。

2. 用乙醇或异丙醇蘸湿无绒擦拭
巾或棉签，然后擦拭触销。安
装卡盒之前晾干触销。

3. 执行以下操作：

a. 在 BioPhase 8800 系统前
面板上，触摸左上角的图
标。

b. 记录固件版本。

c. 请联系 sciex.com/request-
support。

在运行开始时遇到
错误

1. 由于卡盒窗口上发生冷凝，
运行开始时的光学扫描失
败。

2. 打开和关闭光室门导致了传
感器错误。

1. 在关闭方法中，将 Sample
Storage 样本存储温度升高到
20 °C 以防止发生冷凝。

2. 关闭，然后重新打开 BioPhase
8800 系统。确保按照程序更换
UV 滤光器，切勿打开光室门，
除非要求那样操作。请参阅文
档《操作员指南》中的“安装
UV 滤波器”章节。
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症状 可能的原因 纠正措施

宽峰、分辨率低 1. 毛细管末端受损。

2. 样本浓度过高。

3. 毛细管堵塞。

4. 毛细管的内表面被污染。

1. 评估毛细管末端的状况：

• 使用放大镜进行检查。

• 使用无绒实验室擦拭巾沿着
朝外的方向小心地擦拭毛细
管入口。

• 确保毛细管末端从金套管电
极伸出大约 2 mm。

• 确保毛细管末端切割平直。
如果毛细管无法使用，则请
参阅以下章节：毛细管堵塞
或损坏时的选项。

2. 执行下列操作之一或全部操
作：

• 降低分离方法中的 Inject 操
作的 Duration 以减少进样
量。如果结果不能令人满
意，则降低 Pressure 或
Voltage。

• 使用样本稀释剂再次稀释样
本。

3. 请参阅以下章节：毛细管堵塞
或损坏时的选项。

4. 编辑序列以忽略受到污染的毛
细管，或者更换卡盒。

故障排除
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症状 可能的原因 纠正措施

残留 1. 样本浓度过高。

2. 试剂孔板被样本污染。

1. 执行下列操作之一或全部操
作：

• 降低分离方法中的 Inject 操
作的 Duration 以减少进样
量。如果结果不能令人满
意，则降低 Pressure 或
Voltage。

• 使用样本稀释剂再次稀释样
本。

2. 在分离方法中，进样后添加一
个或多个水浸步骤。 利用编辑
过的方法：

a. 创建使用此分离方法的新
序列。

b. 为新序列准备新试剂孔
板。请参阅以下章节：加
载试剂入口和出口孔板。

电流过高 1. 凝胶缓冲剂被污染。

2. 试剂在试剂孔板中的位置与
序列中的孔板布局不一致。

1. 再次准备入口和出口试剂孔板
以更换凝胶缓冲剂。

2. 确保试剂在试剂孔板中的位置
与孔板布局一致。 如果位置不
正确，则按照孔板布局再次准
备孔板。请参阅以下章节：孔
板布局。

电流过低或不稳定 1. 毛细管末端堵塞或污染。

2. 凝胶缓冲剂中有气泡。

1. 请参阅以下章节：清除毛细管
堵塞。如果电流过低或不稳
定，则更换卡盒。

2. 执行下列操作之一或全部操
作：

• 使用离心机在 30 g 的条件下
将孔板旋转 5 分钟，以除去
气泡。

• 使用 5 英寸 Hg 到
15 英寸 Hg 的真空将缓冲剂
脱气 5 分钟。
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症状 可能的原因 纠正措施

电泳图谱样本中缺
失峰

1. 样本制备过程中发生了移液
错误。

2. 方法参数不正确。

3. 试剂在试剂孔板中的位置与
序列中的孔板布局不一致。

1. 制备新的样本。

2. 执行以下操作：

• 在 Method Settings 中，确
保 Detector Type 的值正
确。

• 在分离方法中，确保 Type
of Injection 和 Duration 的
值正确。

• 在分离方法中，确保
Wavelength 的值为
220 nm。

3. 确保样本在样本孔板中的位置
与孔板布局一致。 如果位置不
正确，则按照孔板布局再次准
备孔板。请参阅以下章节：试
剂、孔板布局和方法。

分离期间无电流 1. 毛细管损坏。

2. 电极折断或弯曲。

3. 毛细管末端堵塞或污染。

4. 试剂在试剂孔板中的位置与
序列中的孔板布局不一致。

5. 毛细管中充满气泡。

1. 请参阅以下章节：毛细管堵塞
或损坏时的选项。

2. 更换卡盒。

3. 请参阅以下章节：清除毛细管
堵塞。

4. 确保样本和试剂在孔板中的位
置与孔板布局一致。 如果位置
不正确，则按照孔板布局再次
准备孔板。请参阅以下章节：
孔板布局。

5. 执行下列操作之一或全部操
作：

• 确保样本和试剂孔板的孔中
包含足够的溶液。

• 确保试剂在试剂孔板中的位
置与孔板布局一致。 如果位
置不正确，则按照孔板布局
再次准备孔板。请参阅以下
章节：孔板布局。

• 使用离心机在 30 g 的条件下
将孔板旋转 5 分钟，以除去
气泡。

故障排除
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症状 可能的原因 纠正措施

无峰 1. 已超过紫外线灯的使用寿
命。

2. 方法参数不正确。

3. 样本孔中的气泡会阻碍进
样。

4. 毛细管窗口堵塞。

5. 毛细管末端堵塞或污染。

6. 样本量太少。

7. 样本孔中无样本，或者样本
在样本孔板中的位置与序列
中的孔板布局不一致。

1. 请参阅文档《操作员指南》中
的“安装紫外线灯”章节。

2. 执行以下操作：

• 在 Method Settings 中，确
保 Detector Type 的值为
UV。

• 在 Inject 和 Separate 操作
中，确保 Polarity 的值为
Reverse。

• 在分离方法中，确保
Wavelength 的值为
220 nm。

• 确保分离期间在入口和出口
应用了压力。

3. 使用离心机在 30 g 的条件下将
孔板旋转 5 分钟，以除去气
泡。

4. 检查毛细管窗口。确保窗口洁
净且路径清晰。请参阅以下章
节：检查毛细管卡盒。

5. 请参阅以下章节：毛细管堵塞
或损坏时的选项。调节毛细
管。请参阅以下章节：调节毛
细管。

6. 确保样本孔中有 100 µL 的样
本。

7. 确保样本在样本孔板中的位置
与孔板布局一致。请参阅以下
章节：孔板布局。

电泳图谱中有尖峰 1. 凝胶缓冲剂中有气泡。 1. 执行下列操作之一或全部操
作：

• 使用离心机在 30 g 的条件下
将孔板旋转 5 分钟，以除去
气泡。

• 使用 5 英寸 Hg 到
15 英寸 Hg 的真空将缓冲剂
脱气 5 分钟。

故障排除

CE-SDS Protein Analysis 试剂盒 适用于 BioPhase
8800 系统
60/77

应用指南
RUO-IDV-05-8662-ZH-D



清除毛细管堵塞
1. 用 CE Grade Water 在 75 psi 的压力下冲洗毛细管 10 分钟。

2. 使用 CE Grade Water 清洗毛细管入口。

3. 使用无绒实验室擦拭巾沿着朝外的方向小心地擦拭毛细管入口。

4. 为了评估毛细管的状况，请执行以下操作：

a. 使用直接控制向毛细管中填充分离凝胶。

b. 将入口和出口毛细管放入试剂托盘上的分离缓冲剂中。

c. 应用分离电压，并监测电流的稳定性。

5. 如果未能清除堵塞，则编辑序列以忽略受损的毛细管，或更换卡盒。

毛细管堵塞或损坏时的选项
如果无法清除毛细管中的堵塞或者毛细管已损坏，则编辑序列以忽略堵塞或受损的毛细管。请
参阅以下章节：创建序列。

调节毛细管
• 如有必要，使用 CE-SDS 调节方法调节毛细管。

故障排除
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有害物质信息 A
必须注意以下信息并采取相关安全措施。更多信息请参阅相应的安全数据表。这些安全数据表
可应请求提供，或者通过我们的网站 sciex.com/tech-regulatory 下载。

根据 HCS 2012 的危险等级分类。

Acid Wash/Regenerating Solution (0.1 M HCl)

危险! 造成严重皮肤灼伤和眼损伤。

Capillary Regenerator Solution A Basic Wash (0.1 M NaOH)

危险! 造成严重皮肤灼伤和眼损伤。

CE-SDS Gel Buffer，pH 8，0.2% SDS

危险! 导致轻微皮肤刺激。可能损伤胎儿的生殖能力。

IgG 对照标准品

警告! 导致轻微皮肤刺激。

Low pH SDS Sample Buffer（100 mM Tris-HCl，pH 6.8，1% SDS）

警告! 导致轻微皮肤刺激。

其他试剂

下列成分未分类为有害物质：

• CE Grade Water

• MW Size Standard

• SDS-MW Sample Buffer

• 10 kDa Internal Standard

对于从其他供应商处获得的试剂，使用之前请阅读该供应商提供的安全数据表。

有害物质信息
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下载必需文件 C
根据使用的软件，步骤可能会有不同。

• BioPhase 软件用户，请参阅以下章节：下载和配置必需文件（BioPhase 软件）。

• Waters Empower™ 软件用户，请参阅以下章节：下载和配置必需文件（Waters Empower™

软件）。

下载和配置必需文件（BioPhase 软件）
包含 CE-SDS Protein Analysis 试剂盒的方法、序列、试剂和分析参数的文件可从 sciex.com
上获得。按照下面的说明下载文件，然后将其复制到适当的位置。

注释: 只有在使用 BioPhase 软件 1.1 版时才需要下面的程序。CE-SDS Protein Analysis 试剂
盒的必需文件作为组成部分包含在 BioPhase 软件 1.2 版和更高版本中。

1. 转到 sciex.com/software-support/software-downloads，然后在 More software downloads
部分单击 BioPhase Resources。

2. 单击 BioPhase Project Files 1.2。
3. 在 File Explorer 中，右键单击 BioPhase_1.2.zip 文件，然后单击 Extract All 解压安

装包。

4. 浏览到所需位置，单击 Select Folder，然后单击 Extract。
提取的文件将复制到所选的文件路径。

5. 将提取的文件放在正确的位置。执行以下操作：

注释: 下面的说明假定 BioPhase 软件项目文件夹位于默认位置：C:\Biophase。如果项

目文件夹在不同位置，则将提取的文件放到该位置中。

a. 将 BioPhase_1.2\Projects\CE-SDS 文件夹拖放到

C:\BioPhase\Projects。
b. 将 BioPhase_1.2\Reagents\CE-SDS 文件夹拖放到

C:\BioPhase\Reagents。
c. 将 BioPhase_1.2\Data Analysis\CE-SDS 文件夹拖放到

C:\BioPhase\Data Analysis。

下载和配置必需文件（Waters Empower™ 软件）
CE-SDS Protein Analysis 试剂盒的必需文件可从 sciex.com 上获得。按照下面的说明下载文
件，然后将其复制到适当的位置。

1. 转到 sciex.com/software-support/software-downloads，然后在 More software downloads
部分单击 BioPhase Driver Resources。

下载必需文件
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2. 单击 BioPhase Method Files 1.3。

3. 在 File Explorer 中，右键单击 BioPhase-Empower-Method-Files-1.3.zip 文件，

然后单击 Extract All。

4. 浏览到保存方法文件的位置，单击 Select Folder，然后单击 Extract。
提取的文件会被提取并复制到指定位置。

下载必需文件
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试剂、孔板布局和方法 D
试剂组
如果试剂不可用，则利用下面的内容创建新试剂组。请参阅图：图 D-1 和图 D-2。

图 D-1 CE-SDS Protein Analysis 试剂盒入口试剂

试剂、孔板布局和方法
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图 D-2 CE-SDS Protein Analysis 试剂盒出口试剂

孔板布局

注释: 下图显示了与软件随附的序列对应的孔板布局。对于所有序列，孔板布局都相同。如果
添加了其他样本或编辑了试剂位置，则下列布局不正确。

样本孔板

注释: 顶部行显示样本出口孔板的布局。底部显示样本入口孔板的布局。

试剂、孔板布局和方法
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图 D-3 样本入口孔板和样本出口孔板的布局

试剂孔板

注释: 顶部行显示试剂出口孔板的布局。底部显示试剂入口孔板的布局。

试剂、孔板布局和方法
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图 D-4 试剂入口孔板和试剂出口孔板的布局

试剂、孔板布局和方法
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方法
有关创建方法的说明，请参阅文档：《软件帮助系统》。

方法设置

注释: 将这些设置用于所有方法。

图 D-5 CE-SDS Protein Analysis 方法的方法设置

调节方法

图 D-6 CE-SDS 调节 方法中的操作

试剂、孔板布局和方法
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图 D-7 CE-SDS 调节 方法中的操作概要

非还原样本的分离方法

图 D-8 非还原 CE-SDS 分离方法中的操作

试剂、孔板布局和方法
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图 D-9 非还原 CE-SDS 分离方法中的操作概要

还原样本的分离方法

图 D-10 还原 CE-SDS 分离方法中的操作

试剂、孔板布局和方法
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图 D-11 还原 CE-SDS 分离方法中的操作概要

使用低 pH 样本缓冲剂制备的样本的分离方法

图 D-12 低 pH 样本缓冲剂分离方法中的操作

试剂、孔板布局和方法
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图 D-13 低 pH 样本缓冲剂分离方法中的操作概要

关闭方法

图 D-14 CE-SDS 关闭 方法中的操作

试剂、孔板布局和方法
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图 D-15 CE-SDS 关闭 方法中的操作概要

试剂、孔板布局和方法
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联系我们

客户培训
• 北美地区：NA.CustomerTraining@sciex.com

• 欧洲：Europe.CustomerTraining@sciex.com

• 在欧盟与北美之外请访问 sciex.com/education

在线学习中心
• SCIEX Now Learning Hub

购买用品和试剂
在 store.sciex.com 上在线重新订购 SCIEX 用品和试剂。要建立订单，使用报价、订单确认或
发货单中的帐号。目前，美国、英国和德国的客户都可以访问在线商店，将来会拓展至其他国
家/地区。对于其他国家/地区的客户，请联系当地的 SCIEX 代表。

SCIEX 支持
SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题
或可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com 或通过下述方式之一联系我
们：

• sciex.com/contact-us

• sciex.com/request-support

网络安全
有关 SCIEX 产品的最新网络安全指南，请访问 sciex.com/productsecurity。

文档
本版本的文档取代本文档的所有先前版本。

要查看本文档的电子版本，需要 Adobe Acrobat Reader。要下载最新版本，请转到 https://
get.adobe.com/reader。

要查找软件产品文档，请参阅软件随附的版本发行说明或软件安装指南。

要查找硬件产品文档，请参阅系统或组件随附的文档。

最新版本的文档可从 SCIEX 网站上获得，网址：sciex.com/customer-documents。
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注释: 如需免费获取本文档的印刷版本，请联系 sciex.com/contact-us。
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